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About WaterMaze 
WaterMaze was written and designed by David Ferster of Actimetrics, Inc., and by Richard Morris and 
Patrick Spooner of WaterMaze Software.  

About the program 

WaterMaze is a computer program for automatically tracking and analyzing the path of an animal 
swimming in a large pool of water. It may also be used for a variety of other experimental procedures 
that involve the tracking of animal movements through space. 

Flexibility 

WaterMaze has been designed to provide individual experimenters with the maximum of flexibility in 
how experiments are run and analyzed. For example, it can automatically track the path of either an 
albino or a hooded animal (usually a rat or mouse) without the necessity of attaching either light 
emitting diodes or reflective material to the animal, or altering program parameters. Training may be 
conducted with the escape platform in a fixed position, or with it moving to different places from trial to 
trial. Once a trial sequence is specified at the start of an experiment, the program’s unique Project 
Manager module keeps track of the sequence of animals and trials over the duration of the experiment. 
The program can be set such that each animal gets all its daily trials together before the next animal is 
run, or with all animals being trained on one trial before they are moved on to the next. The program 
alerts the experimenter as to the next animal in the sequence to be run, the starting location of the trial, 
and the platform location. Data files are created automatically and trials stored in the correct file. The 
experimenter can easily override the Experiment Manager where appropriate and arrange trials in any 
sequence on demand. 

Ease of use 

For all its flexibility, WaterMaze is easy to use. Because we are WaterMaze users as well as designers, 
we have taken extra care to make WaterMaze a natural extension of the experiment itself. Controls and 
menus are placed in logical and intuitive arrangements. Anyone familiar with using Microsoft Windows 
will have no difficulty in learning to use WaterMaze quickly. Help routines are provided throughout 
the program.  

Video acquisition 

During the trial, the video capture card installed in the PC grabs images at up to 8 frames per second. 
The program can track any moving object in the scene, identifying the swimming animal whether it 
swims over objects that are lighter or darker than it. A unique algorithm screens out shadows and 
lighting changes that might occur during the trial, making for rock-solid tracking. An on-line 
interpolation routine identifies and smoothes occasional loss of signal that can occur if an animal swims 
briefly underwater or under hanging cue objects. The path taken, with interpolated values, can be 
displayed in real time as the trial proceeds. At the end of each trial, the experimenter can type in notes 
concerning the trial just completed. After the intertrial interval, whose duration is specified by the 
experimenter, the path taken by the animal is automatically saved for later analysis (with other useful 
information about the trial). The program then displays the animal and platform location of the next trial 
in the experimental sequence. 
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Multiple data analysis options 

After one, or a series of trials, or when an entire training session is completed, various types of Data 
Analysis may be chosen. In the onscreen Trial Viewer, any trial can be easily selected from trial lists, 
and a complete set of analysis parameters will be displayed, along with a picture of the swim path. 
Alternatively, the Batch Analysis window can be used for analyzing large numbers of trials. Any 
combination of analysis protocols can be applied to almost any combination of trials and animals. The 
results are saved in a spreadsheet-compatible file for printing or for further analysis. Analyses range 
from the basic — such as latency or path-length — to the complex — such as quadrant analysis, heading 
direction, and other parameters taken from the latest literature. Not all of these analyses need be 
computed in every experiment; different users may select only those analyses most useful for their own 
application. Finally, the image of the swim path may be exported to drawing or illustration programs, 
such as Photoshop, Illustrator, PowerPoint or Corel Draw, where the image is fully editable. 

Advanced Features 

WaterMaze incorporates a number of advanced features not found together on other more costly 
tracking systems. These include the Project Manager and state-of-the-art frame grabbing technology just 
described. In addition, WaterMaze includes facilities for control of the on-demand or ‘Nautilus’ 
platform, which can be triggered to rise to near the surface of the pool if and only if the animal swims in 
the appropriate location for a pre-defined period of time. Other features will be added as new techniques 
develop. (Tell us your favorite analysis protocol or suggest a feature that will make your experiments 
easier.) Program upgrades will be available at no additional charge. 

Hardware Requirements  

WaterMaze runs under the Windows 2000 or Windows XP operating system on all PC-compatible 
computers with a Pentium processor of at least 800 MHz clock speed. 256MB of RAM is recommended.  

 

Installation 
WaterMaze 3 can be installed on Windows XP or Windows 7.  The system will interface to the 
computer using either USB or PCI interface.  This option is determined at the time the system is 
purchased and the hardware for will differ depending on which interface format is being used.  If the 
system was purchased recently the USB format will be used.  If you are upgrading a previously 
purchased system of WaterMaze or WaterMaze 2 and are using the same cameras and interface that was 
included with the original system then your system will be using the PCI interface format. 

Setup for USB  
1. Insert the Install DVD Disk that was included with the ACT-710 ACTIMETRICS USB 

INTERFACE.  After a few moments the disk will start to run automatically and the window in 
Figure 1 will be displayed.  If the program does automatically start then open up Windows 
Explorer, select your DVD drive and double click the “Autorun.exe” file. 

2. Move the mouse cursor over the “Step 1 – Install the USB cameras and software” and left click 
the mouse once.  The drivers for the SenTech USB cameras (StCamSWare) for the USB cameras 
will be installed.  Follow the on screen instructions to complete the installation of the USB 
camera drivers. 
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FIGURE 1 

 

3. After the SenTech USB camera drivers have been installed, move the mouse cursor over the 
“Step 2 – Install the ACT-710 USB Drivers” box and left click the mouse once.  A Windows 
Explorer window will appear with a listing of the files in the “NIDAQ890-1” folder on the DVD.  
Double click on the “setup.exe” file.  Follow the on screen instructions for installing the NI-
DAQ drivers that are required for the ACT-710.  This part of the installation will take a few 
minutes. 

4. Following the completion of the installation of the NI-DAQ drivers for the ACT-710, click the 
“Finish” button to remove the install window, then click the “Restart Later” button, and close the 
Windows Explorer window.   Move the mouse cursor over “Step 3 – Install the National 
Instruments Drivers” box and left click the mouse.  A new Windows Explorer window will 
appear with a listing of the files located in the “VISIONACQ” folder on the DVD.  Again, 
double click on the ‘setup.exe” file to begin the installation of the National Instruments drivers.  
Follow the on screen instructions to continue the installation.  This will require quite a few 
minutes to complete.  During this part of the installation you may be requested to inset Disk 2.  
Simply ignore the instruction and click the Cancel option. 

5. Install the camera by connecting the USB cable to any USB Port.  The Windows hardware 
wizard will run.  Once the camera is installed the SenTech camera can be adjusted by running the 
StCamSware software. 
 

6. Install the ACT-710 Actimetrics USB Interface into any USB Port. 
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7. Now install the WaterMaze Software.  You can download the WaterMaze 3 installation file by 
clicking on the “Step 4. Download Actimetrics Software” of the ACT-710 installation DVD or 
going to http://actimetrics.com/downloads/ and selecting WaterMaze 3.  The User ID is 
behavioral and the Password is Neuro11. 

8. Extract the files from the zipped file using WinZip, WinRar, or another file extraction software 
package.  Once the files are extracted run the setup.exe file by selecting Start > Run and then 
browsing to the folder on your computer containing the extracted files. 

9. The first time WaterMaze 3 is run, a serial number will be displayed.  E-mail the serial number 
to Coulbourn Instruments at sales@coulbourn.com and you will receive a Password to unlock 
WaterMaze 3 and a VisionWare license.  For each installation of WaterMaze you will require a 
VisionWare license.  The purchase of the WaterMaze 3 software or upgrade entitles you to three 
VisionWare licenses.  Additional licenses can be purchased from Coulbourn Instruments. 

PCI  INSTALLATION 
1) Install the WaterMaze software, image acquisition card and drivers  

• Before installing the video board, load the NI-IMAQ software from the CD provided with the 
PCI-1407 (P/N ACT-650).  

• Before installing the digital I/O board, load the NI-DAQ software from the CD provided with 
the PCI-6503 (P/N ACT-675) which is required only if using Nautilus On-Demand Platform 
(P/N ACT-203).  

• Shut down the computer and plug the PCI-1407 (ACT-650) and PCI-6503 (ACT-675) boards 
into open PCI-slots. The PCI-1407 should be closest to the processor.  

• Run the WaterMaze installer program, if you have not already. 

 

2) Connect the camera 

• Connect the camera output connector to the "Video" input on the PCI-1407 (ACT-650) using the 
BNC cable provided. 

• Connect the camera to the 24VAC power supply using the two-stranded wire provided. Ignore 
the wire colors; polarity is unimportant since this is an AC power supply. 

• Plug the power supply into any 120V-60Hz outlet.  

3) Test the camera 

• From Windows's START menu, select Programs->National Instruments IMAQ -> Explore 
IMAQ. 
A Window entitled "Exploring - Measurement and Automation" should appear. 

• In the list to the left of the window, open Measurement & Automation\Devices and 
Interfaces\IMAQ PIC-1407:img0\Channel 0: rs 170  
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• From the tool bar, select Grab. You should now see a real-time image from the camera. If no 
image appears, check the power and signal connections from the camera and video board. If you 
still have trouble, call National Instruments at 800-433-3488 and ask for help with NI-IMAQ.  

• PCI-1411 of PCI-1409: Click the Properties button in the toolbar and set the Bit Depth to 8-Bit 
or Luminance 8-bit. 

• Once you have verified that the camera is working and properly connected to the image 
acquisition board, you may quit the camera test program by clicking the close box at the upper 
right of the window  

4) Configure the computer's speakers and sound card 
WaterMaze relies on the computer's sound card and speakers for generating tones that guide the user 
through a trial. Connect the computer's speakers as in your computer manual and test the sound system. 
You can test the system by playing a CD (from the START menu, choose Accessories->Multimedia-
>CD Player), or by opening the Sounds control panel, selecting a sound and playing it using the 
rightward pointing arrow ("Preview:"). 

If the sounds do not play, check the speaker connections, whether they are turned on and whether the 
volume is set high enough. Next check whether the drivers for the sound card that came with the 
computer are properly installed and functional. If they are not, consult with the computer manufacturer.  

If you are able to play a CD or a sound in the Sounds control panel, FreezeFrame should be able to play 
conditioning stimuli as well. 

5) Mount the camera 
Mount the camera securely above the center of the pool. Be sure that the power and signal cables are 
secured so that they cannot be jostled during a trial. Any motion of the cable will move the camera ever 
so slightly, disrupting tracking. Adjust the zoom and aim of the camera so that the water surface fills the 
center of the image. Focus carefully! 

6) Run WaterMaze 
When you first run WaterMaze, it will display a serial number and ask for a password. Contact 
Coulbourn Instruments (sales@coulbourn.com) with your serial number and a password will be e-
mailed to you.  Enter the password.  The password is keyed to your PCI-1407 (ACT-650) image 
acquisition board. You may transfer the program and board to any computer and the same password will 
apply.  

 

7) Install and test the remote control switches for Nautilus On-Demand Platform 

• Install the PCI-6503 (ACT-675) board for use with a switch interface box  

o Double-click the Measurement & Automation icon. The icon appears on the desktop 
when the NI-DAQ CD is properly loaded.  

o Select "Devices and Interfaces".  

o Select the PCI-6503. If the PCI-6503 is not listed in the window, then the board or the 
NI-DAQ software is not properly installed.  

o Double-click the "Device Number" item in the right-hand window.  
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o In the dialog box that appears, set Device Number to "1".  

o Click the Test Resources button and make sure that the device passes the test. Contact 
National Instruments if it does not (800-433-3488).  

• Connect the PCI-6503 to the switch interface box using the 50-pin ribbon cable provided.  

• Connect a switch to the TRIG input connector on the PCI-1407 or, if installed, connect one or 
more switches to the switch input of the interface box.  

• Open the Switches Window in WaterMaze (SETTING -> SWITCHES menu).  

• Set which switch control which functions during the WaterMaze trial.  

• Press and hold the switch and verify that the appropriate Switch indicator lights.  

See Appendix A for a diagram of the hardware connections for the Nautilus On-Demand 
Platform. 

8) Adjust the lighting 
Good lighting is critical for proper tracking!  

There are three main considerations for good lighting, shadows, reflections, and evenness. 

Shadows: People moving around in the experiment room should not cast strong shadows on the tank. 
WaterMaze's tracker has a built in algorithm that compensates for changing lighting conditions during a 
trial. Nevertheless, a strong shadow cast on the tank during the course of a trial can potentially disrupt 
tracking. Therefore, lights should not be placed in such a way that an experimenter can walk between a 
light and the tank. The same is true for brightly lit walls. An experimenter walking in front of a brightly 
lit wall can dramatically change the amount of light falling on the tank. 

Reflections. Light placed above the tank can be reflected from the surface of the water directly into the 
camera lens, especially when there are ripples on the surface caused by the animal's swimming. Check 
the image to see that reflected images of the lights are not visible in the image. In addition, ripple the 
water surface lightly with your fingers. Even if the lights are not reflected into the lens when the water 
surface is flat, ripples made by a swimming animal can sometimes cause reflections. When lighted 
ripples are observed, move the lights farther away from the pool. 

Evenness. It is important that all portions of the pool be lit evenly. Several light sources placed at points 
around the pool should be used. Check the evenness lighting using the Luminance Profile window, 
accessible from the PREFERENCES -> BRIGHTNESS PROFILE menu. 

The best lighting is indirect light reflected off the ceiling. A few inexpensive halogen floor lamps 
aimed at a flat, white ceiling above the pool give fairly even, reflection-free light. In addition, by 
lighting the ceiling instead of the walls of the experiment room, the chance that someone moving in the 
room will cast a shadow on the pool is reduced. Light reflected off of a wall is also effective, as long as 
no one walks between the wall and the tank during a trial. Light reflected off a single wall, however, is 
likely to leave the edge of the pool nearest the wall poorly lit. Make sure a second, and even a third light 
source is placed opposite the lighted wall to compensate.  

Note that the light level need not be over bright. Most cameras automatically adjust their sensitivity to 
the ambient light level.  
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9) Test the tracking 
Open the Set Pool Window (SETTING -> POOL menu) and adjust the pool setting to match the pool 
image. Set up a project with trials of long duration, and run a trial using an artificial animal to test 
tracking. We use a cardboard cutout the size of the animal's head, mounted on a long piece of very thin, 
stainless steel tubing. Darken the tubing with a black marker pen so that the program tracks the cutout 
and not the tubing. A floating object the size of an animal's head can also be used. Check to see that the 
program can track an object in every region of the pool. If not, adjust the lighting to be more even, and 
to minimize shadows and reflections (see Lighting section above). 

10) The Nautilus Platform 
To control the Nautilus platforms, you must install a National Instruments PCI-6503 Digital input/output 
board and switch interface box as described above.  

You may control 8 different Nautilus platforms independently from the first 8 control lines of the board 
(see Switches Window). One platform control output is brought to a phone jack on the front of the 
switch interface box. The other 7 outputs are available on the DB-15 connector on the rear of the box 
(contact Actimetrics for details). Which control line will be used for each platform is specified in the Set 
Platforms Window.  
 

Quick Start: Designing and Running a Project 

Designing a Project 

1. Follow the Installation instructions carefully. Pay close attention to lighting of the pool. 

2. Open the Pool Window (SETTINGS -> POOL menu) and adjust the circle defining the pool to 
match the pool's image. 

3. Open the Preferences Window (SETTINGS -> PREFERENCES menu) and choose appropriate 
values for all the settings. 

4. Select the FILE -> NEW menu item to start a new project. 

5. Select the FILE -> SAVE menu item to save and name the project. 

6. Set up the Project's Platforms using the PROJECT -> PLATFORMS menu. 

7. Set up the basic project using the PROJECT -> DEFAULTS menu. 

8. Specify the animal names individually in the Animal Name control, or specify the name of the 
first animal and select the PROJECT -> SEQUENCE NAMES menu item. 

9. Edit the trial sequence for each animal if necessary. Select each animal in turn using the Select 
buttons, and edit trial sequence (# of days, conditions per day, and trials per condition, 
platform, and trial duration). 

10. Select the FILE -> SAVE menu to save the project design.  

Running a Project 

1. Select RUN from the MODE menu. 

2. Use the Do Next, Do Selected, or Sequence buttons to run trials.  
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o Take a reference frame prior to placing the animal in the pool using the onscreen 
Reference Frame button or Remote control button.  

o Place the animal in the pool and start the trial using the onscreen Start button or 
the Remote Control button.  

o Stop the trial when the animal reaches the platform using the onscreen Stop 
button or the Remote control button.  

o Save the trial using the Save button or wait until the trial is saved automatically at 
the end of the intertrial interval.  

Analysis 

Use the View or Export windows (accessed from the ANALYSIS menu) to analyze trials.  

 

Settings Windows 
Setting the Pool 

The Set Pool Window is used to tell WaterMaze where the pool is located within the camera image and 
how large it is. Presently, the program assumes that the pool is circular. 

When the window opens, you will see a real-time image from the camera with several superimposed 
cursors (2 vertical and 1 horizontal line) and the pool circle. Use the cursors to superimpose the circle on 
the outline of the pool image. 

Cursors. The cursors consist of 2 vertical and 1 horizontal one. 

• If these lines are not visible in the image window, click the Center control to bring them into view.  

• The color of the cursors can be adjusted using the Diagonals color box.  

• The position of the most recently selected cursor can be adjusted one pixel at a time with the Nudge 
control (four grey diamonds on a blue background).Use the upward and downward pointing diamonds for 
the horizontal cursor, and the leftward and rightward point diamonds for the vertical cursors.  

Diagonals. As a reference point to the center of the image, the image diagonals can be displayed using 
the Diagonals button.  The color of the diagonal lines is controlled by the Diagonals color box. 

Pool Diameter. Enter the diameter of the pool in centimeters into this control. 

Note: This control must be properly set, or measurements of swim velocity and distance will be 
incorrect. 

Note also: Changing the pool settings will alter the positions and diameters of the platforms used 
in ongoing projects. If you change the pool settings in the middle of a project, be sure to check the 
platform settings. The analysis of trials already completed will not be affected.  

Pool color. The color of the pool circle can be changed with this control. 

Swim Path. Clicking the Show/Hide button displays a sample swim path. Adjust the colors of the 
points and line with the corresponding controls. The swim path will be displayed in the WaterMaze 
Window using these colors. 
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Save & Exit. Closes the Window. Changes made are saved into the MWMConfig file.  

Cancel. Closes the window without saving the changes made. 

Luminance Profile Window 

The Luminance Profile window is used to measure the evenness of lighting across the pool. The camera 
image is shown, together with two cursors, one a horizontal line and the other a vertical line. The graph 
above the image shows the luminance of the camera image along the horizontal cursor; the graph to the 
left of the image shows the brightness along the vertical cursor. The luminance scales of the two graphs 
run from 0 to 255 or from the minimum to the maximum possible values. 

For the best tracking performance, it is best to adjust the lighting in the room so that the luminance 
profile across the pool is as even as possible. See "Adjusting the Lighting" in Hardware installation.  

Preferences Window 

The Preferences Window is used to set various infrequently changed program parameters. 

Trial Parameters 

Default Trial Duration: The Trial Duration control in the Project window (Design mode) is set to this 
value by default. This is maximum time a trial is allowed to run, usually the time at which the 
experimenter places the swimming animal is placed on the platform. Typical values are 120 sec (rats) 
and 90 sec (mice).  

Intertrial Interval: When the Sequence function is selected from the Project window (Run mode), 
trials are done one after another automatically. After a trial is completed (that is, the program stops 
recording the swim path), the program will wait for the Intertrial Interval, then automatically save the 
trial data and proceed to the next trial. The Intertrial Interval may be overridden by clicking the Save or 
Exit buttons in the WaterMaze window. The countdown to the automatic saving of a trial can be 
interrupted by the Pause button that appears in the WaterMaze window during the intertrial interval. 

Autostop Trial: When this control is checked, the program stops recording the animal's swim path after 
a fixed delay (Autostop Time) from the time that the animal first reaches the platform. The animal must 
stay on the platform for the entire duration of the Autostop Time in order for the trial to be stopped 
automatically. If the animal leaves the platform, the autostop timer is reset to 0. If the platform is an 
Nautilus Platform, then the program stops when the platform is raised.  

Tracking parameters: 

Frame Rate: Controls the rate at which the WaterMaze window collects and analyzes images during a 
trial. The maximum rate at which data can be sampled is dependent on the speed of the computer's 
processor. For a 450 MHz computer, for example, the program can't go much faster than 6 frames per 
second. If the frame rate is set higher than the computer can handle, the WaterMaze program will go as 
fast as it can. That it is not going as fast as specified will be indicated by the appearance of a Frame 
Rate indicator appearing in the WaterMaze Window showing the real rate. Skipped frames are not a 
serious problem. Except for the reduced sample rate, data collection continues without any harm done.  

Save Images: WaterMaze can save images from a trial onto your hard drive for later review. Saved 
images are also useful for hand-editing trials in which tracking errors occurred (though the goal is, of 
course, to minimize such errors). It is therefore good practice to save images. Image files are stored in 
the project folder. They take considerable space on the hard drive and so should be regularly discarded 
or archived on CD, DVD or tape. 
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Sounds 

Sounds: The WaterMaze program uses sounds delivered through the computer's speakers to indicate the 
three phases of a trial. Sound 1 is played intermittently to indicate that a Reference Frame must be taken. 
Sound 2 sounds briefly when a trial is started. Sound 3 sounds briefly when a trial is stopped. Specify 
the details of each sound using the corresponding Frequency and Volume controls. Play a sample of the 
sound using the Test buttons. If no sound can be heard, check the volume setting on the computer's 
external speakers. If sounds still are not audible, test the computer's sound card using the Windows 
Sounds Control Panel. The sound card's drivers may be improperly installed.  

Frequencies can range between 100 and 5000 Hz. Volumes can range between 0 and 255. 
 

Switch Settings and Connections 

Trial Control. 

During each WaterMaze trial, four specific functions need to be performed: taking a Reference frame, 
Starting the trial, Stopping the trial, and Saving the trial. On-screen controls are provided in the 
WaterMaze Window to perform these functions (and two of these functions can be automated in the 
Preferences Window). In addition, these four functions may be performed using remote control buttons.  

Five different inputs may be used for the remote control buttons: 

• TRIG. The PCI-1407 video acquisition board has a BNC connector labeled TRIG.  

• DIGITAL PB0-PB3. If you have installed a PCI-6503 digital input/output board, four of its 
pins are automatically configured as inputs for remote control switches.  

o PB0-PB3 correspond to pins 33, 31, 29 and 27 on the PCI-6503.  

o PB0-PB2 can be accessed from the 1/8" (3.5 mm) phone plugs on the front of the 
switch interface box provided. Connect the switch in the normally open 
configuration across the two connectors of the phone plug.  

o Alternatively, PB0-PB7 can be accessed on the DB-15 connector (labeled 
"Switches") on the back of the interface box at pins 1-8. Connect the switch in the 
normally open configuration between the selected pin, and any of pins 9-15 
(ground).  

You may configure the program so that any one of the four WaterMaze control functions is controlled 
by any of the 5 digital 2nputs. Use the 4 Signal popup menus to set the corresponding input. Note that 
more than one function can be assigned to each button. If no PCI-6503 is installed, for example, all four 
functions are assigned to the TRIG input. In that case, the one button performs each of the four functions 
in sequence. The sounds played during the WaterMaze trial (set in the Preferences Window) indicate 
which function the button will perform at each point during the trial. 

Each of the 5 inputs is configured to operate when grounded. When the input is left open the inputs read 
as FALSE. When grounded the input reads as TRUE. 

When a properly connected switch is closed, the indicator to the right of the Trial Control cluster should 
turn red. 
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Nautilus On-Demand Platform Control  

You may use up to 8 different control lines on the PCI-6503 (PA0-PA7) to control Nautilus platforms. 
In the Set Platforms Window, each Nautilus Platform can be set to be controlled by a different line. 
Here, you may test each output line of the PCI-6503 using the corresponding button. Set the Release 
button to the UP position to drive the corresponding output high (+5V).  

• The pin numbers on the ribbon connector of the 6503 are also indicated for each line in 
the Switch setting window.  

• PA0 can also be accessed from a 1/8" (3.5 mm) phone plug (labeled "Nautilus") on the 
front of the switch interface box provided. The center terminal is signal.  

• Alternatively, PA0-PA7 can be accessed on the DB-15 "Nautilus" connector on the back 
of the interface box at pins 1-8. Pins 9-15 are connected to ground.  

 
 

Project Windows 
The Project Window Menus and Controls 

The Project Manager keeps track of the animals and the sequence of trials to be performed by each 
animal. The Project Window has two modes of display, which are chosen from the MODE menu. The 
Design Mode is used to specify all aspects of the Project, including the animals in the project, the 
locations of the platforms to be used, and the number and sequence of trials, including the number of 
trials to be performed in each day, which platforms will be used for the different trials, the duration of 
each trial, and so on. The Run Mode is used to run the trails in the project in the desired sequence. 

MENUS 

The Project Menu (Handling Project Files) 

NEW: To create a new project, select the NEW menu item. The current project and all its parameters 
cleared from memory.  

OPEN: To open an existing project, select the OPEN... menu item and select a previously saved project 
file.  

SAVE: To save the current project, select the SAVE menu item. If the project has already been named, 
any changes will be saved into the existing file. If the current project is a new one and has not yet been 
saved, you will be prompted for the filename. 

SAVE AS: To save the existing project with a new name, select the SAVE AS... item and you will be 
prompted for a new project file name. 

The Project Window title bar: The title bar displays the name of the currently open file, such as  

Project Manager: Mutants 10-20  

When changes are made to a Project, an "*" is appended to the file name to indicate that unsaved 
changes have been made. The "*" is cleared when the changes are saved.  
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The Settings Menu (Program Settings) 

The Settings menu items are used to specify settings that are not associated with a Project, and are rarely 
changed.  

POOL: The POOL menu item opens the Set Pool window in which you tell the program where the pool 
is in the video image. Be sure to update the POOL setting whenever the camera or pool is repositioned. 

PREFERENCES: The Preferences window is used to specify various default parameters, such as the 
frequency of the sounds used to indicate the switch mode during a trial, the intertrial interval, etc... 

SWITCH TEST: The Switch window is used to set and test the operation of the switch used to start and 
stop trials and to test the operation of the Nautilus Platform controls (if these are installed). 

The Mode Menu (Run/Design) 

The Project Window has two modes of display. The single item in this menu is used to switch the 
Project Window between Run mode and Design mode. The name of the item changes according to 
which mode the program is currently in. 

DESIGN MODE: This is used to specify all aspects of the Project, including the number and names of 
animals in the project, the locations of the platforms to be used, and the number and sequence of trials, 
including the number of trials to be performed in each day, which platforms will be used for the 
different trials, the duration of each trial, and so on.  

RUN MODE: This is used to run the trials in the project in the desired sequence.  

The Design Menu (Designing a Project) 

DEFAULTS: Opens the Basic Project window, which is used to specify the default parameters used for 
the trial sequence in each animal, such as the platform to be used and the default trial duration. 

PLATFORMS: Opens the Set Platforms window. Used to specify the number, names, locations, and 
properties of the platforms to be used in the project. Platform settings are stored in the Project file. 
Therefore, if the PLATFORM item is selected and no Project file has been opened, a warning is 
displayed. 

START LOCATIONS: The user may specify up to 30 different starting locations for each project. 
Depending on which location is specified for a trial, a small dot is placed in the WaterMaze Window 
image to indicate where the animal should be placed in the pool. Selecting this menu items opens the Set 
Start Locations window, which is similar in layout to the Set Platforms window. Locations are used only 
as a guide for the user during a trial.  

SEQUENCE NAMES: This feature is useful if the animals to be studied in the project are numbered in 
sequence. For example, imagine that the 12 animals in a project are named "mutant045", "mutant046", 
"mutant047",... "mutant056". Enter the "mutant045" into the Animal Name text box for animal 1, set 
the # of animals to 12, and select the SEQUENCE NAMES menu item. WaterMaze will fill in the 
names of the remaining 12 animals by adding 1 to each name. 

CLONE TRIALS: Opens the Clone Trials window, which is used to copy the trial settings for one 
animal to the settings for any number of other animals.  

NOTES: Opens the Notes window. A descriptive note can be entered for each animal. The notes are 
stored in the Project file. 
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INTERLEAVE ANIMALS: Specifies the order in which a day's trials are performed. With this menu 
item checked, trials are performed in the order animal 1 - trial 1, animal 2- trial 1, animal 3- trial 
1,...animal 1 -trial 2, animal 2 - trial 2... With the INTERLEAVE ANIMAL item unchecked, the day’s 
trials for animal 1 are completed before proceeding to animal 2, etc. In either case, the specified order of 
trials can be overridden using the Select and Do Selected controls when running trials. 

The Analysis Menu 

VIEW: Opens the Analysis View window, which is used for viewing the swim path and analysis 
parameters for individual trials. 

EXPORT: Opens the Analysis Export window, which is used for exporting analysis parameters for 
groups of animals into spreadsheet compatible files. 

SETTINGS: Certain analysis functions can be modifies by setting associated control values in the 
Analysis Settings window. 

The Help Menu 

Show/Hide Tool tips: Many controls have tool tips associated with them, brief explanatory messages 
that pop up when the cursor is held over the control for a few seconds. Use this menu to turn on (default) 
or off these messages (which can get annoying once you've learned the program). 

Help: Opens this help system in Windows Explorer. The help file for a given program window can be 
reached directly by typing F1 at any time in the program. 

CONTROLS 

Design Mode 

Animal Controls 

The controls to the left of the screen specify the number of animals in the project and their names.  

# of animals: Specifies the number of animals in the project. A number may be typed in or the arrows 
used to change the number. 

Animal Name: Type the name of each animal into the corresponding row. Or type in the first name and 
use the DESIGN -> SEQUENCE NAMES menu item.  

Select: To view the trial sequence for any one animal, click the corresponding Select button. 

Trial Controls 

The controls to the right of the screen specify the trial sequence for the animal that is selected by the 
Select buttons. These controls are the heart of the Project Manager and are used to specify the exact 
sequence of trials to be performed for the selected animal. Make sure you specify the starting positions 
and platform locations before specifying the trial sequence.  

# of days: Specifies the number of days that the animal will be run. 

Conditions/day: Specifies the maximum number of different conditions that will be used in a single 
day. A condition is comprised of a platform and default trial duration. Note that a condition, which 
includes a platform, a start position, a maximum trial duration, is distinct from a trial performed using 
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that condition. That is, an animal may be trained for several trials per day to a single condition. If each 
day, the same platform, start position and maximum duration will be used, then conditions/day can be 
set to 1. 

Conditions: The cluster of controls labeled "Conditions" takes on the number of rows specified in the # 
of days control, and the number of columns specified in the Conditions/day control. Thus, an 
experiment lasting 5 days with 2 conditions would have 5 rows and 2 columns. 

For each condition, you may specify the Number of trials to be performed, the Start location to by 
used, which Platform to use for the trials and the default Duration for the trials. For example, consider 
an animal that is to be trained for 4 trials/day with the platform moving location between trial 1 and trial 
2 and not thereafter. There are 2 conditions and thus 2 columns. The first condition should be set at 1 
trial and the second set at 3 trials. Before setting up a trial sequence, Start locations and Platforms 
should first be defined using the corresponding options in the Design Menu. 

Discard: Depress this button to eliminate an animal from the project for any reason after the project 
trials have started. 

Locked: This button is depressed whenever the trials for the selected animal have begun. When it is 
depressed, the trial parameter controls (# of days, Conditions/day, etc.) are disabled and cannot be 
changed. To re-enable these controls, click again on the Locked button to turn off the locked condition. 
You may now change the trial parameters for the selected animal. Doing so is dangerous, however, and 
may corrupt the data that have been already collected. CAUTION! Changing the number of trials 
that are to be done on a day for which all trials have been completed will have disastrous 
consequences. Doing so will corrupt data that have already been collected. 

Run Mode 

Trial Controls 

Show Next: Indicates which animal is next in the Project sequence by highlighting the corresponding 
Select button for that animal. 

Do Next: Determines which animal is next in the specified Project sequence and opens the WaterMaze 
window with the corresponding platform, trial duration and animal name.  

Sequence: Same as Do Next, but instead of returning to the Project window when the trial is done, the 
WaterMaze window is opened repeatedly according to the specified trial sequence. The Sequence mode 
is canceled when the Cancel button in the WaterMaze Window is pressed (instead of the Save button). 

Do Selected: Opens the WaterMaze window with the name, platform and trial duration for the animal 
specified by the Select buttons. Thus, the Do Selected button overrides the sequence specified for the 
Project. 

Animal Controls 

Animal Name: Indicates each animal's name. This control is disabled in RUN mode, and enabled in 
DESIGN mode. You may not change the name of an animal once a trial has been performed for this 
animal. Animal names may not contain any of a set of reserved characters, including < > | , . ? ! \ and /. 

Select: Displays the Trial List for the selected animal. To perform a trial on one animal, click the 
corresponding Select button and then the Do Selected button in the Trial Controls cluster (above). 
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Day/Trial: (Indicator only). They indicate the day and trial number of the last performed trial for the 
corresponding animal. If for example, the second trial on the 4th day of trials has been performed, and 5 
trials are to be run on the 4th day, the Day indicator will read "4" and the Trial indicator will read "2/5". 

Trial List: The trial list shows a complete list of the trials performed and to be performed for the 
selected animal. The columns indicate for each trial: the trial number, the day on which the trial is to be 
run, the trial number for that day, the name of the platform to be used, and -- if the trial has been run -- 
the trial duration. 

Discard: Same as in Design Mode. Click on the button to eliminate an animal from a project once the 
project's trials have begun. When the Discard button is depressed, the animal will be skipped by the 
program when Show Next, Do Next or Sequence are selected. An animal may be temporarily discarded. 
If for some reason, you wish to defer performing an animal's trials until the end of the day, for example, 
press the Discard button, perform the trials for the remaining animals using the Do Next or Sequence 
buttons, then press the Discard button again and use Do Next or Sequence (or Do Selected) to return to 
the deferred animal. 
 
 

The Basic Project (Defaults) 

This window allows you to specify some basic default aspect of a Project. When setting up a new 
project from scratch, this window should be used first, especially when the trial sequence for the animals 
in the project are to be very similar. The window settings are adopted for all animals. Settings may be 
changed in the Project Manager window for individual animals and individual days as desired. 

# of animals. Sets the number of animals in the Project.  

# of days. Sets the starting # of days for all animals in the project. These may be changed later for 
individual animals within the Project Manager window. 

Trials per day. Sets the starting Trials per day for all days and all animals in the project. These may be 
changed later for individual animals within the Project Manager window. 

Platform. Sets the starting Platform for all days and all animals in the project. These may be changed 
later for individual animals within the Project Manager window. 

Trial duration. Sets the starting Trial Duration for all days and all animals in the project. These may 
be changed later for individual animals within the Project Manager window. 
 

Setting the Platforms 

The Set Platforms window is used to specify the location and properties of the multiple platforms to be 
used in a Project. The Window contains a real-time view of the camera image, and several controls and 
cursors for changing platform settings. 

Copying platform settings from another Project File 

The platform settings are stored in the Project File. You may find that you would like to start a new 
project using the same platform settings that were established in a previous project file. Instead of 
setting up the platforms again from scratch in the new project, open the old project file, select FILE -> 
SAVE AS... and save the old project file with a new name. Now edit the animal and trial settings in the 
new file, leaving the platform settings intact. 
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Setting a Platform 

1. Select the number of the platform you would like to edit using the Selector popup-
menu.  

2. Enter the name of the platform into the Name text edit box.  

3. Indicate whether the platform is to be physically present or not using the Present 
checkbox. Unless an Nautilus platform is to be used, this setting has no practical effect 
on the running of an actual trial. It can be used as an aid in setting up a trial or in later 
analysis.  

4. Indicate whether an Nautilus Platform is to be used. If so, a set of controls becomes 
visible at the bottom right of the window for setting the Nautilus Platform parameters.  

o Trigger diam and Dwell Time. The Nautilus platform will be raised when the 
animal remains within a trigger zone defined by the Trigger diameter 
(centimeters) for a period defined by the dwell time.  

o Raise after. If, after the period defined by this control (seconds) the animal has 
not triggered the raising of the platform by swimming in the Trigger zone, it will be 
raised anyway.  

o Color. Defines the color of the circle that is to indicate Nautilus trigger zone in 
both this window and in the WaterMaze window.  

o Trigger line. The Nautilus Platform is controlled from the PCI-6503 Digital I/O 
board. With this control you may specify which of the 24 digital lines of the 6503 
will be used for each Nautilus platform. Each platform may be controlled by a 
different line. Trigger lines 1-8 control pins 47, 45, 43, etc. on the 6503.  

5. Set the diameter of the platform (centimeters) using the Diameter control.  

6. Move the platform into the desired position using the cursor at the center of the platform 
circle.  

o If the platform circle and cursor are not visible on the screen, click the Center 
Cursor button to bring them into view.  

o Use the color box to set the color of the platform circle in this window and in the 
WaterMaze window.  

o The Nudge control (grey diamond on blue background) can be used for fine 
control over the position of the platform circle.  

o The X and Y indicators show the position of the platform center with respect to 
the center of the pool. They are updated by moving the cursor of the platform, but 
cannot be entered directly.  
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Markers  

Various markers can be displayed in the image to guide the placement of the platforms.  

• Diagonals. These define the center of the pool (not the center of the image). Diagonal 
colors are set in the Set Pool window.  

• Marker Circle 1 and 2. These are concentric with the pool and their diameters 
expressed as a percentage of the pool diameter. Circle colors are the same as for 
diagonals (set in the Set Pool window).  

• Pool. Shows the outline of the pool. Color is set in the Set Pool window.  

Save and Exit  

Closes the window, on one case Saving the platform setting to the currently open project file. 

Cancel 

Closes the window without saving any of the changes made. 
 

Clone Trials 
The Clone Trials window is used to copy the experimental trial sequence from one animal to 
another. For example, after setting up a complex series of trials for one animal in a project, you 
can copy the series to all other animals in the project.  
In the From listbox, select one animal whose trial sequence you wish to copy.  

In the To listbox, select multiple animals whose trial sequences will be replaced with that of the animal 
selected in the From list. (Shift-Click to select more than one animal.)  

Click the Clone--> button to copy the trial sequences according to the listbox selections and return to the 
Project Manager window. 

Click Cancel to return to the Project Manager window without making any changes. 

 

Notes 

This window allows you to save notes in the Project file, one note per animal. 

Simply select an animal in the Animal listbox and type any desired text into the Note text edit box. 
Notes may be added and amended at any time during an experiment. 

Save & Exit and Cancel close the window either with or without saving the changes made.  
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WaterMaze Window 
Running a Trial (The WaterMaze Window) 

The WaterMaze window is reached from the Project Manager Window. In the Run mode, click the Do 
Next, Do Selected or Sequence button. The WaterMaze Window opens showing  

• The name of the animal to be run  

• The trial number for the animal  

• The next animal in the sequence to be run  

• The camera image  

• The name of the platform to be used  

• The outline of the platform (and the Nautilus platform trigger zone) superimposed on the 
image  

• A small spot to indicate the starting location specified by the user  

The Reference Frame. You must capture a reference frame before the animal is introduced into 
the tank. WaterMaze finds the animal in an image by comparing that image to a reference frame, that is, 
an image of the tank taken without the animal in it. Prior to each trial, therefore, WaterMaze plays an 
intermittent tone to remind you to take the reference frame. Press the Reference Frame control in the 
WaterMaze Window, or press the Reference remote control switch until the tone ceases. You may set 
the pitch and volume of the tone in the Preferences Window (Sound #1). 

Starting the trial. Once the reference frame has been taken, the trial can be started. Introduce the 
animal into the tank and immediately press the Start control in the WaterMaze Window, or press the 
remote switch once. This starts the trial, as indicated by a brief tone, the frequency and volume of which 
are set in the Preferences Window (Sound #2). Make sure you have introduced the animal into the 
pool and moved out of the image before pressing the start button, or the animal will not be 
tracked properly during the first few frames of the trial. 

Running the trial. The trial proceeds automatically. An asterisk-shaped cursor indicates where the 
program has located the animal. If the Show Path button is on, the swim path is plotted as the animal 
swims. The color of the swim path points is set in the Set Pool Window.  

Stopping the trial. A trial can be halted in one of four ways. 

• Press the Cancel button. This halts the trial and exits the WaterMaze Window without 
saving the trial.  

• Press the Stop button or the Stop remote switch. This halts the trial and plays Sound 
#3. The trial can then be saved (with the Save button or the remote control switch) or 
discarded (with the Cancel button).  

• Select AutoStop Trial in the Preferences Window. In this case, the trial is automatically 
halted when the animal reaches the platform and stays in it for the time specified in the 
Preferences window (Autostop time).  
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• The trial times out because the animal does not reach the platform in the time specified 
for this trial by the Trial Duration in the Project Window.  

Swim Path. At the end of the trial, the swim path points (which are displayed during the trial) 
are connected by a line, the color of which is set in the Set Pool Window. The line skips those 
points in the path for which the calculated swim speed exceeds the Velocity Threshold set in the 
Preferences Window. The program assumes that these point represent errors by the tracking 
algorithm and so it edits this points out of the path and instead extrapolates the path between 
valid points recorded prior to and following the errors. 

Saving the trial. Press the Save button or the Save remote control switch to save the trial. Press the 
Cancel button to exit the WaterMaze window without saving the trial. If the WaterMaze window has 
been opened using the Sequence button in the main window, at the end of the trial a timer appears and 
begins to count down the seconds starting from the Intertrial Interval that has been set in the 
Preferences Window. The Pause button temporarily halts the countdown. The trial is saved when the 
timer reaches 0. To override the timer and save the trial immediately, press the Save control, or the Save 
remote control switch. The trial is appended to a file named for the animal, and the WaterMaze window 
closes. If the trial has been started using the Sequence button in the Project Window, then the 
WaterMaze Window will automatically open again for the next trial in the Project.  

Note: Occasionally, the animal you have actually run may not be the animal that is indicated in the 
window (under "Animal" at the upper right of the window). Sometimes the operator can mistakenly 
choose a different animal from the one requested by the program. Instead of throwing out the trial, you 
may use the Animal popup menu to correct the error, by selecting the animal that was actually run. Of 
course, this feature will not be very helpful if the platform for the requested animal and the platform for 
the animal that was run are different.  

Nautilus Platform control. If the platform specified for the trial has been set up as an Nautilus 
platform, several indicators will appear at the lower left of the image window. The Dwell Time and the 
Raise After time (both set in the Set Platform Window) are shown in digital indicators and each has an 
associated slide indicator. The Trigger Zone (also set in the Set Platform Window) is indicated as an 
extra circle surrounds the position of the platform in the image window.  

During the trial, the Raise After slide indicator will gradually turn red. When the duration of the trial 
reaches the Raise After time, the indicator becomes completely red and the platform will be released. 
That is, the digital line on the PCI-6503 that has been selected for the current Nautilus platform (set in 
the Set Platform and Switches Windows) will be driven high (+5V). 

Once the animal enters the trigger zone (selected in the Set Platform Window), the Dwell Time slide 
indicator will start to turn red. If after the Dwell Time, the animal has remain in the trigger zone 
continuously, the indicator turns completely red and the platform is released. The indicator is reset to 
zero if the animal exits the trigger zone before the indicator turns completely red.  

Frame rate. This indicator will appear only if the computer cannot sample as fast as the Frame Rate 
specified in the Preferences Window. It shows the actual frame rate at which the data are being 
recorded. This indicator is merely a warning, and not a serious error. Except for the lowered sample rate, 
data collection is unaffected. To avoid this warning, lower the Frame Rate specified in the Preferences 
Window. 
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Analysis Windows 
The Trial Viewer Window 

The trial viewer can be used to view and analyze any completed trial in the Project. Open the Trial 
Viewer window by selecting the Analysis -> View menu of the Project Manager window. To view a 
trial: 

1. Select the animal for which you would like to view a trial using the Animal listbox.  

2. Select the trial that you would like to view using the Trial listbox. The trials that have 
been completed have the Time entry in the Trial listbox filled in.  

3. Select the portion of the trial you wish to analyze using the Trial Subset controls. The 
Start and End controls determine the start and end of the portion to be analyzed in 
either seconds or percent, depending on the setting of the accompanying switch. The 
All button sets the switch to "%" and the start and end times to 0 and 100.  

For the selected trial, several types of information are displayed. Some analysis variables are associated 
with a control parameter as listed below. 

• Platform Parameters. Position, diameter, present?  

• Nautilus Parameters. Nautilus?, trigger diameter, dwell time, raise after.  

• Trial Duration. The total recording time.  

• Distance Traveled (Path length). Path-length is calculated using Pythagoras theorem 
on separated pairs of coordinates. The separation (in image frames) is determined by 
the Smoothing control. This smoothing acts as low-pass filter that reduces jitter, i.e., 
the number of occasions that the distance calculation is artifactually increased when the 
image-analyzer cursor jumps from the rats black head to black marks on its body, or 
between points reflecting small head-movements.  

• Average Speed. Distance/Time (cm/sec). In our experience in Edinburgh, speed is 
remarkably uniform at circa 25 to 30 m/sec for animals swimming in water at 25 C. 
Speed declines slightly as animals get tired (e.g. after several successive long trials).  

• % time near walls. Percentage (%) of time spent within a specified distance from the 
side walls of the pool. The boundary distance is specified in centimeters using the 
Width control. The analyses is useful for assessing thigmotaxic tendencies in animals, 
which can be increased in animals given high doses of anticholinergic drugs, or certain 
kinds of brain lesions. The Show button makes visible the region near the walls used in 
the analysis.  

• Directionality. Directionality measures the animal's heading in degrees of angle relative 
to the platform at a selected distance along the path from the start. The point at which 
directionality is to be measured is indicated in centimeters using the Distance control. 
The animal's direction is calculated as a line through two points in the path, one 3 
frames back from the selected distance, and one 3 frames ahead. When the animal is 
heading in a direction clockwise from the platform, angles are reported as positive. The 
Show button makes visible the two vectors used in the calculation.  
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• Gallagher's Proximity. Derived from Gallagher, Burwell & Burchinal, 1993, Behavioral 
Neuroscience, 107: 618-626. The animal's distance to the platform is first averaged over 
each 1-second interval of the trial.  

o Average proximity. The distance to the platform is averaged over the first N 
seconds of the trial, where N is the setting in the Time (sec) control. According to 
Gallagher et al., this measure is useful for probe trials in which the platform is 
absent.  

o Cumulative proximity. The first A seconds of the trial are removed, where A is 
the animal's starting distance to the platform divided by the average speed over 
the whole trial. The 1-second averages of distance-to-platform for the remainder 
of the trial are summed. According to Gallagher et al., this measure is useful for 
training trials.  

o Average proximity opp and Cumulative Proximity opp. Average and 
cumulative proximity are calculated for a virtual platform located across the 
center of the pool from the platform actually used during the trial.  

• Whishaw's error. Percentage (%) of time spent inside a corridor 
centered on a line extending from the start point of the path to the center 
of the platform (outlined in red in the figure to the right). The corridor 
width (in centimeters) is specified by the Corridor width control. The 
corridor can be made visible using the Show controI.Q.Whishaw 
(Behavioral Neuroscience, 1985) introduced this simple error measure 
as a count of the number of trials for which animals would successfully swim to the 
platform by taking a path within a prescribed corridor of, in his case, 18 cm width. Our 
adaptation of this measure calculates the percentage of time that the path is inside the 
user-defined corridor. Users may therefore set different tolerances for counting a trial as 
correct or in error. For example, you may set a corridor width of 18 cm also, but decide 
that a trial may count as correct if at least 85% of the path is inside the corridor. We 
make no specific recommendation.  

• Quadrant analysis.  

o Quadrant Times (sec). Time (sec, to 1 decimal place) in each quadrant of the 
pool. Quadrants are listed in the order NE, NW, SW, and SE. Their boundaries 
are the vertical and horizontal lines that cross the center of the pool.  

o Quadrant Times (%). Same as Quadrant Times (sec), but expressed as 
percentage of total trial time.  

o Platform Crossings. The number of times the animal 
crosses over 4 different platform locations. One of the 
locations is the one specified by the user and chosen 
for the trial (solid line in figure to the right). The other 
three platform locations used for this calculation are 
placed in positions equivalent to that of user platform 
relative to each quadrant (dotted lines in the figure).  

o Time to platform. The time to the first crossing of 
each of the 4 platform locations (the user platform and 
the three equivalent virtual platforms.  
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NOTE: The quadrants can be reported in one of two orders, as determined using the 
Quadrant Display control in the Analysis Settings window: 

o By Compass: Quadrant data are ordered counterclockwise by compass points 
NE NW SW SE.  

o By Platform: Quadrant data are ordered clockwise relative to the quadrant 
containing the platform:  

 Adj L: the quadrant immediately counterclockwise from the quadrant 
containing the platform  

 Training: the quadrant containing the platform  

 Adj R: the quadrant immediately clockwise from the quadrant containing 
the platform  

 Opp: the quadrant opposite the platform  

• Zone Analysis. The percent time spent within N cm of each of the platforms in the 
project is reported. The distance N is set using the Radius control.  

Exporting the Swim Path. Select the Save Picture item from the File menu to create an EPS 
(Encapsulated PostScript) file containing the swim path, pool outline and platform position, as shown in 
the path window. These files can be opened by most modern drawing programs, such as Corel Draw, 
Adobe Illustrator, and PowerPoint. 

Exporting the analysis. Select the Export Trial item from the File menu to export the analysis 
parameters to a spreadsheet-compatible file. You may either create a new file or select an existing file, 
in which case the data will be appended to the file. This feature is similar to the function of the Export 
window, but will only export the data for one trial at a time. Whichever file you choose to write to will 
automatically be opened in Excel once the selected trial analysis is written. Remember to close the file 
in Excel before trying to write another trial to it: The file you choose to export to must not be opened 
within Excel or some other program, or WaterMaze will not be able to write to it.  

Editing the path. If, despite all efforts, the tracking fails during part of a trial, and setting the Velocity 
Threshold control does not clean up the path, it is possible to edit the path of a trial using the Edit Path 
window, which can be reached from the Trial Viewer by selecting the EDIT -> PATH menu item. Or 
double-click a trial in the trial list to open it in the Edit Path window. 

Exporting AVI Movies. It is possible to export saved images to an AVI-formatted movie. AVI files can 
be imported into PowerPoint or other presentation software. From the Trial Viewer Window, select the 
FILE -> CREATE AVI MOVIE menu item. The AVI Utility window opens.  

• Use the yellow Movie controls (reverse, pause, step, forward and fast forward), the 
corresponding MOVIE menu items or slide the Time control at the bottom of the screen 
to select the starting point of the movie.  

• Click the Start Movie button and specify a filename using the file dialog that appears.  

• Use the Movie controls to play the desired portion of the movie.  

• Click the Stop Movie button.  
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• You can create additional movies from other parts of the image file, or Select the FILE -
> EXIT menu item to return to the Trial Viewer.  

Quick Scrolling. You may quickly scroll through all the trials for a single animal by clicking on the 
Trial listbox and then hitting the UP or DOWN arrow keys on the keyboard. Similarly, you may scroll 
through the first (or second, or third...) trial for each animal by clicking on the Animal listbox and 
hitting the UP or DOWN arrow keys. 

 The Export Window  

The Export Window is used for creating spreadsheet-compatible files containing analysis parameters for 
multiple trials in a Project. 

Selecting trials for analysis 

1. Select the animals for which trials are to be analyzed. Shift-click on one or more animals 
in the Animals listbox. Use the All buttons to select all the animals in the list, or None 
button to clear the list.  

2. Select the trials for analysis by number. For example, to analyze the 1st, 3rd and 5th 
trials for each selected animal, set the # control to 3, then fill in the Trials control with 1, 
3 and 5. Alternatively, use the All button to select all trials, or the Last button to analyze 
the last trial for each selected animal.  

3. Select the portion of each trial (in seconds or %) using the Trial Subset controls.(See 
Trial Viewer window for more on this.)  

Analyses. Select the analyses that you wish to have calculated and exported. Analyses are explained in 
detail in the Trial Viewer window. Some analyses are associated with a control parameter. These are set 
in the Analysis Settings Window. Some settings are also accessible in the Trial Viewer window.  

• Platform Parameters. Position, diameter, present?  

• Nautilus Parameters. Nautilus?, trigger diameter, dwell time, raise after.  

• Trial Duration. The total recording time.  

• Distance Traveled (Path length).  

• Average Speed.  

• % time near walls.  

• Directionality.  

• Gallagher's Proximity.  

• Whishaw's error.  

• Quadrant analysis.  

o Quadrant Times (sec).  

o Quadrant Times (%).  

o Platform Crossings.  
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o Time to platform.  

• Zone Analysis.  

Exporting 

Click the Export button. You will be prompted to specify a file name. The file will automatically be 
given the extension ".csv". By clicking the Open in Excel button to the on position, after the file is 
written it will automatically open in Excel. Note that if the file already exists and it is already open in 
Excel, an error will result (WaterMaze will not be able to overwrite the existing file). 
 

The Analysis Settings Window  

The Analysis Settings Window is used to set various parameters that control the analysis of each trial. 
The parameters are relevant to the Export Analysis and View Analysis Windows. 

Smoothing: Path-length (Distance traveled) is calculated using Pythagoras theorem on separated pairs 
of coordinates. The separation in time (in image frames) between points used to determine distance is 
determined by the Smoothing control. This smoothing acts as low-pass filter that reduces jitter, i.e. the 
number of occasions that the distance calculation is artifactually increased when the image-analyzer 
cursor jumps from the rats black head to black marks on its body, or between points reflecting small 
head-movements.  

Width. Affects the thigmotaxis (% time near walls) calculation, that is the percentage of time the 
animal spends within a specified distance from the side walls of the pool. The boundary distance is 
specified in centimeters using the Width control.  

Distance.Relevant to the Direction calculation. Directionality measures the animal's heading in degrees 
of angle relative to the platform at a selected distance along the path from the start. The distance at 
which directionality is to be measured is indicated in centimeters using the Distance control.  

Time. Affects the calculation of Gallagher's proximity. See Trial Viewer window.  

Corridor width. Affects the calculation of Whishaw's error. See Trial Viewer window.  

Time. Affects the calculation of Gallagher's proximity. See Trial Viewer window.  

Radius. Affects the calculation of proximity measurements . See Trial Viewer window.  

Velocity Threshold. This setting can help to minimize the effects of tracking errors on analysis. When 
the tracker fails, the animal location can jump randomly around the pool from frame to frame, resulting 
in anomalously high swim velocities. The analysis program suppresses any points in the path that show 
a velocity higher than the velocity threshold and instead interpolates between adjacent valid points in 
the path. A threshold about 3-fold higher than the highest expected swim velocity is appropriate (about 
45 cm/sec) for mice.  

Quadrant Display: Quadrants analyses can be reported in one of two orders, as determined using the 
Quadrant Display control: 

By Compass: Quadrant data are ordered counterclockwise by compass points: NE-NW-SW-SE. 

By Platform: Quadrant data are ordered clockwise relative to the quadrant containing the platform:  
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• Adj L: the quadrant immediately counterclockwise from the quadrant containing the 
platform  

• Training: the quadrant containing the platform  

• Adj R: the quadrant immediately clockwise from the quadrant containing the platform  

• Opp: the quadrant opposite the platform  

  


